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Introduction
Thank you for purchasing the AES16™!  We are proud to provide you with a reliable, professional quality product for your digital audio
requirements. This Installation and Users Guide provides basic information to help you get started.

Before You Begin
Before you begin the installation of your AES16 card, we recommend that you read through the Installation and Users Guide to acquire an
overview of the installation  procedure and use of the AES16. You should have a working knowledge of Windows and general PC concepts.
Additionally, refer to your computer’s documentation for any special instructions regarding the installation of expansion cards and
peripheral equipment.

Contents
Verify that you received the following in the AES16 shipping carton:
• AES16 PCI Card in cushioned antistatic bag
• Two AES16 Cables (CBL-AES1604 six-foot cable with 8 XLR connectors) Models AES16-XLR and AES16-SRC only.
• Setup and Documentation CD ROM
• Warranty Registration Card

Optional Equipment
The following equipment may be required depending on the configuration of your system and the type of devices the AES16 is connected
to:
• CBL-AES1603  26-pin high-density male D-sub to 25-pin male D-sub. Supports either 8 channels of input or output Compatible with

Apogee AD16 and DA16 Twelve-foot, 110-ohm shielded twisted pair cabling
• CBL-AES1605  26-pin high-density male D-sub to 25-pin male D-sub. Supports 4 channels of input and output. Compatible with

devices with standard Yamaha digital I/O pinout from Yamaha, Apogee, Mackie, and others. Twelve- foot, 110-ohm shielded twisted
pair cabling

System Requirements
Verify that your computer meets or exceeds the following configuration:

• Intel Pentium-class processor or 100% compatible
• Apple Macintosh G4 or later
• 1 empty PCI Slot
• Video display with 1024x768 resolution
• 32 MB RAM
• Windows 2000/XP
• Macintosh OS9 or OSX

Manual Conventions
This manual uses the following typographic conventions:
• Underlined text denotes characters that are to be typed using the keyboard.
• ALL UPPER CASE text denotes the names of specific connectors.
• First Character Upper Case text denotes AES16 Mixer control names or menu options.
• Italic text denotes emphasis or a warning.
• Phrases, such as  Start > Programs > Lynx Studio Technology,  use the greater than (“>”) sign to separate multiple menu options or

icon names that are selected with a keyboard or mouse action.

Introduction
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Introduction

Warranty Registration
We are committed to providing you with the best service possible.  To help us serve you better, please be sure to register your AES16 using
one of the following methods:

1. Fill out and mail the Warranty Registration Card included with your AES16.

2. Use the Online Registration Wizard. To start the wizard, click on Start > Programs > Lynx Studio Technology > Online Registration
Wizard. If you do not have an internet connection on the computer you installed your AES16 in, simply copy the REGISTER.EXE
program from the C:\Program Files\Lynx Studio Technology folder to a computer with an internet connection and run REGISTER.EXE
from there.

3. Register on the web at:
http://www.lynxstudio.com/support.html

Once you are registered you will automatically receive notifications of new products and upgrades.

Locating the Serial Number of Your AES16
To register your AES16, you must supply its serial number. The serial number is located on a label attached to the back of the card and on
the shipping carton. You can also determine the serial number of your card by selecting About Mixer in the Mixer menu of the AES16
Mixer.  When registering with the Online Registration Wizard, the serial number will be automatically entered.
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Installation

Windows 2000/XP® Installation
The procedure for installing the AES16 in Windows 2000/XP requires that you install your AES16 inside your computer before the AES16
Setup Program is run. This program will install all the required driver files and the AES16 Mixer application as well as configure your
system to recognize the AES16.

Installing the AES16
1. Turn OFF the power to your computer system and disconnect the power cords.
2. Touch a metal plate on your computer system to ground yourself and discharge any static electricity.
3. Remove the cover from your computer system case. You should refer to your computer system documentation for any special

instructions on installing expansion cards and peripheral equipment.
4. Find an empty PCI slot in your computer.
5. Unscrew and remove the slot cover from your selected PCI slot.
6. Remove your AES16 from its static bag and gently insert it into the selected PCI slot. Press it down firmly so that the contacts are

securely seated in the slot.
7. Secure the AES16 card with the screw removed from the slot cover.
8. Replace the computer system case and plug in your computer.
9. Connect the cables to the AES16. See the External Connections section for more information.

Running Setup
1. Turn on your computer and start Windows.
2. When Windows 2000/XP loads, you will receive a “Found New Hardware” notification followed by a “Found New Hardware Wizard”

window. Press “Cancel” to continue.
3. With Windows running, insert the CD-ROM supplied with your AES16 into your computer’s CD-ROM drive.
4. Select “Start” from your system menu, then “Run…”.
5. Type d:\SETUP.EXE into the Run window (where d: is the drive letter of your CD-ROM) and select the OK button.
6. The “LynxTWO Windows NT Driver Installation Wizard” will appear.
7. After reading the instructions on the screen, press “Continue”.
8. The Driver Installation Wizard will copy all of the files needed to the appropriate directories.
9. When the “Installation Complete” message appears, read the instructions on the screen, then press “Close”.
10. Please read the “LynxTWO Release Notes” in the start-up menu “Lynx Studio Technology” group.
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External Connections

Connections

Digital Audio I/O
The AES16 includes eight AES/EBU compatible inputs and outputs which provide 16 channels of digital audio I/O . These signals are
available on two bracket-mounted 26-pin high-density D connectors, labeled I/O Port A and I/O Port B as shown in the figure below. To
accommodate a wide range of studio equipment, the signal routing on each of these ports can be configured using the I/O Configuration
jumpers to support either four inputs and four outputs or eight inputs or outputs. The next section describes how to set these jumpers.

To minimize cabling issues, a variety of breakout cables are available for the AES16. The AES16-XLR and AES16-SRC include two
CBL-AES1604 break-out cables with XLR connectors for digital audio signals and female BNC connectors for clock input and
output. The CBL-AES1603 cable provides connections to equipment with eight channel AES/EBU D-sub ports, while the CBL-
AES1605 provides connections to equipment with four input / four output AES/EBU D-sub ports (standard Yamaha pinout).

Referring to figure above, locate I/O Port A and the I/O Port B on the mounting bracket of the AES16. Insert the 26-pin male connector on
the CBL-AES1603, CBL-AES1604 or CBL-AES1605 and tighten the thumb screws on the cable shell.

I/O Configuration Jumpers
As stated earlier, I/O Port A and I/O Port B can be configured  to support two different I/O routing modes. The routing mode is selected
by the position of two 8-position I/O Configuration Jumpers on headers JP5 and JP6. The mode selected must be compatible with the
AES16 breakout cable being used.

For connections to equipment with D25 connectors supporting four AES/EBU inputs and outputs, both of the
I/O Configuration Jumpers should be set to the 4/4 CHNL position on JP5 and JP6 as shown on the left. This
is the factory default position and is the position required for the CBL-AES1604 and CBL-AES1605 cables.

For connections to equipment with D25 connectors supporting eight channels of input or eight channels of
output, the I/O Configuration Jumpers should be set to the 8 CHNL position on JP5 and JP6 as shown on the
right. In this position, I/O Port A provides eight AES/EBU inputs and I/O Port B provides eight AES/EBU
outputs. This is the required position for CBL-AES1603.

In either I/O Configuration mode, a clock input signal  is available on I/O Port A and a clock output signal is
available on I/O Port B. These signals are available on the BNC connectors on CBL-AES1604 breakout cable.

Header
LStream

Port

Header
CLOCK IN

Port

Header
CLOCK OUT

Port

AES16

I/O PORT A

I/O PORT B

LSTREAM

I/O Port A

I/O Port B
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External Connections

Digital Audio Connectors
The XLR connectors on the CBL-AES1604 Cable, labeled IN 1, IN 2, IN 3, IN 4 and OUT 1, OUT 2, OUT 3, OUT 4 are used for AES/
EBU digital audio connections. The CBL-AES1604 connected to I/O Port A will be used for IN 1 through IN 4 and OUT 1 through OUT 4.
The CBL-AES1604 connected to I/O Port B will be used for  IN 5 through IN 8 and OUT 5 through OUT 8.

Clock Input and Output Connectors
The BNC connector labeled CLOCK on the CBL-AES1604 Cable connected to I/O PORT A is used to synchronize the AES16 with
external equipment. The connector supports a TTL signal and should be connected with 75-ohm coaxial cable. Connect the this input to the
clock output of an external device and select External as the Sample Clock Source in the AES16 mixer. Adjust the Sample Clock Reference
to match the incoming clock type.

The BNC connector labeled CLOCK on the CBL-AES1604 Cable connected to I/O PORT B is a word clock output that tracks the sample
rate of the AES16. Connect this output to the word clock input of an external device.

Header Connectors
The Header connectors labeled CLOCK IN and CLOCK OUT are used to synchronize the AES16 with equipment located inside your
computer. For systems containing multiple AES16’s, these connectors are utilized to synchronize the sample clocks of each card. The
connectors support TTL level signals and should be connected using the Lynx Internal Clock Cable (CBL-ICC), Lynx Universal Clock
Cable (CBL-UCC) or similar 75-ohm coaxial cable.

Connect the CLOCK IN connector to the clock output of an internal device and select Header as the clock source in the AES16 mixer.
Adjust the clock Reference to match the incoming clock type.

The signal on the CLOCK OUT header is a word clock that tracks the sample rate of the AES16. Connect this output to the word clock
input of an internal device or another AES16.
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Using Your AES16

Using Your AES16
With the AES16 and its drivers properly installed in your computer, you can begin to use its capabilities with any third party audio
application running under Windows or ASIO compliant applications. In order for these applications to access the AES16 you must select
one of the AES16 audio devices in an application’s configuration menu for audio or wave. Refer to the “Working with Third Party
Applications” section for more information regarding device selection.

The Lynx Mixer
The Lynx Mixer, which is installed during setup, provides software control of the features of the AES16 and a visual indication of audio
signal level during recording and playback.

It can be used dynamically to change operational settings of the AES16, but in most cases once the settings are configured for a particular
studio installation they require no adjustment.

Starting the Mixer
After installation, the Lynx Mixer icon , will appear on the Windows Quick Launch bar in the lower portion of your screen. By
clicking on this icon with your left mouse button, the Lynx Mixer will launch.

If the icon does not appear on the Windows Quick Launch bar, the Lynx Mixer can be started be selecting Start > Programs > Lynx Studio
Technology > LynxTWO Mixer.

General Operation
If you are simply recording and playing digital audio without synchronizing to an external clock source,  you can begin using the AES16 by
simply selecting the AES16 audio devices in your application software.

Typically, it is convenient to keep the Mixer running on your Windows desktop to monitor signal  levels or to allow instant access to Mixer
controls requiring dynamic changes. The Mixer can be forced to appear on top of other applications by selecting the “Always On Top”
option in the Settings pull-down menu.

For further information about the AES16 Mixer controls refer to the “AES Mixer Reference” section for a complete description.

Mixer Configuration Recall
The state of the Mixer settings are saved each time Windows is shut down. The stored settings are automatically recalled the next time
Windows is restarted.

Clock Source Requirements
A valid clock source signal must be connected to the appropriate AES16 clock connector when the Sample Clock Source is set to External,
Header or one of the Digital Inputs.  If a signal is not present, the sample clock generator will run very slowly or erratically. Symptoms of
this problem include audio files that sound either fast, slow or garbled. The AES16 also includes a SynchroLock clocking system to provide
robust synchronization to degraded input clock signals. Refer to the SynchroLock section for a detailed description and other requirements.

When a valid clock source is present, the frequency and type of clock signal must match the Sample Clock Reference setting selected in the
Mixer. The frequency of word clock sources, chosen by setting the Sample Clock Source/Reference to External/Word, Header/Word or
Digital In/Auto, must match the sample rate specified when recording new files or the sample rate associated with a previously recorded file
during playback. For example, if a 44.1 kHz word clock is connected to the external clock input, the Sample Clock Source/Reference must
be set to External/Word and the sample rate must be set to 44.1 kHz when a new file is being recorded in an application. Failure to do so
will result in files being recorded at the wrong sample rate.

Volume Faders and Signal Quality
The faders in the AES16 Mixer perform digital attenuation on audio signals in the digital domain. The attenuation is applied to the digitized
signals just prior to the D/A converters.

As with any digital signal processing function, the digital attenuation calculations used by the AES16 can introduce arithmetic errors that
can add small amounts of noise to signals. To insure the highest signal quality it is highly recommended that the faders be left in their
maximum position during critical recording and playback. In this position, no attenuation calculations are performed.

Mono Recording and Playback Operation
When recording a file in mono, the AES16 will provide an audio signal from the left channel only. The audio signal from right channel is not
used. When playing back a file in mono, the AES16 will send the signal to both the left and right outputs. To force playback on a single
output, turn up the volume for the desired output, and turn down the volume for the output to be muted.
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Using Your AES16

SynchroLock™
The AES16 incorporates SynchroLock clock synchronization technology to provide extreme tolerance to noisy external AES/
EBU and word clock signals while generating an ultra-low jitter clock. This technology is especially useful for combating noise
induced on cables in complex studio installations. SynchroLock provides clock synchronization while insuring bit-perfect
digital transmission. When the AES16 is connected in an AES/EBU daisy chain, SynchroLock acts like a jitter firewall to
prevent the propagation of jitter to downstream devices.

By coupling statistical analysis with low-noise clock generation techniques, SynchroLock is capable of attenuating jitter on
incoming AES/EBU signals by a factor of 3000:1. Compare this to attenuation of 100:1 or less for professional quality analog
phase-lock loops (PLL). SynchroLock, can easily handle AES/EBU signals with jitter levels in excess of 800 nanoseconds.

The SynchroLock sample clock is a two-stage system that is comprised of a fast-locking analog PLL and digitally controlled
crystal-based secondary stage. Due to extensive number crunching of the secondary stage, SynchroLock typically requires
one to two minutes to achieve final lock. While the secondary stage is working, the fast-locking PLL loop maintains lock, but
with much less jitter attenuation than the secondary stage.

When the final lock state is achieved, the secondary stage is switched on line and becomes the system clock source. In some
cases this switching process may cause a momentary disruption in digital I/O. Because of this, it is recommended that
recording or playback not be started until the green LOCK indicator in the SynchroLock status window is observed. This
status window is located on the Adapter page of the Lynx Mixer.

SynchroLock works on any external word clock signal. By default, SynchroLock is active when the Sample Clock source is set
to a clock source other than Internal. When the clock source is set to External, Header, or LStream the Reference must be set to
Word. SynchroLock can be disabled in the settings menu of the mixer by clicking on Settings > Advanced > SynchroLock, but
this is not recommended.

SynchroLock is capable of locking to word clock frequencies within +/- 100ppm of 44.1 kHz, 48 kHz, 88.2kHz, 96 kHz, 176.4 kHz,
or 192 kHz. Signals that fall outside of the lock range will cause the red RANGE indictor to appear in the SynchroLock status
window.

Windows Quick Audio Test
The installation of your AES16 can be tested using the Lynx Mixer and the Sound Recorder application that ships with Windows 2000/XP.
Any other audio application capable of audio recording and playback can be used in a similar manner.

1. Connect a signal source to the IN 1 connector on the CBL-AES1604 cable connected to I/O Port A.
2. Connect the OUT 1 connector to an external device capable of delivering an audio signal for listening via headphones or speakers.
3. Open the LynxTWO Mixer by clicking on the mixer icon in the Windows Quick Launch bar.
4. In the LynxTWO Mixer, select Mixer > Restore Defaults to set the mixer controls back to the factory presets.
5. Unmute the Monitor Mute buttons for both the left and right channels. You should hear the signal from the audio source which is

connected to the analog inputs. If this is not the case, check your connections.
6. Disable input monitoring by again clicking on the Mute buttons on the Record 1 device. After doing so, the buttons should look like

they are in the “out” or non-depressed position.
7. Start Sound Recorder by clicking Start > Programs > Accessories > Multimedia > Sound Recorder. Position Sound Recorder on your

screen so it be easily viewed along with the LynxTWO Mixer.
8. In Sound Recorder, select the AES16’s audio devices by opening the Edit menu and selecting Audio Properties.  Select AES16 Play 1

as the Preferred device for playback and AES16 Record 1 as the Preferred device for recording.
9. Record a short sample by clicking the red record button followed by the stop button in Sound Recorder. You should observe a graphic

display of the waveform being recorded in the center display in Sound Recorder. You should also see activity on the Record 1 peak
meters of the LynxTWO Mixer.

10. Playback the test sample by clicking the play button in Sound Recorder. During playback, you should observe a graphic display of the
waveform being played in Sound Recorder. You should also hear the recorded audio and see activity on the peak meters of the
LynxTWO Mixer.

If the test did not operate as described or you received any errors, please refer to the “Troubleshooting” section of this manual.
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Mixer Reference

Sample Clock - Provides control of the Sample Clock and reference. All AES16 audio devices on a
single card MUST have identical sample rates. Sample rates cannot be changed when AES16 is playing
or recording.

Rate: Displays the current sample rate of the AES16.

Source:
Internal – Clock derived from the on-board crystal oscillator.
External– Clock signal from the SYNC IN connector on the CBL-AES1604 cable.
Header– Clock signal from the board-mounted CLOCK IN header.
LStream– Clock signal from the LStream port on the CBL-AES1604 connector.
Digital In 1 – Clock signal from the Digital 1 Input
Digital In 2 – Clock signal from the Digital 2 Input
Digital In 3 – Clock signal from the Digital 3 Input
Digital In 4 – Clock signal from the Digital 4 Input

Reference – Provides selection of the clock source reference type from one of the following:
Auto – Automatic selection. Valid for Internal, Digital, and Video clock sources.
13.5 MHz – 13.5 MHz video dot clock. Valid for External and Header clock sources.
27 MHz – 27 MHz video dot clock. Valid for External and Header clock sources.
Word – Word clock. Valid for External,  Header, and LStream clock sources.
Word256 – 256 times word clock. Valid for External and Header clock sources.

Window One - Adapter

Status and Settings for Sample Clock, Digital I/O
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Mixer Reference

Window One - Adapter (continued)

Status and Settings for System Clock Rates
Wide Wire™ and SynchroLock™

Wide Wire™: Allows selection of Dual-Wire mode.

SynchroLock™: Shows the status of  SynchroLock clocking system

When checked, the AES16 is in dual-wire mode, for eight channels at 48 kHz to 192 kHz sample rate. When not selected, the AES16 is in
single-wire mode for sixteen channels at all available sample rates.

SynchroLock is Lynx Studio Technology’s proprietary technology for attenuating jitter on clock inputs and providing a stable clock for all
digital signals passed through the AES16. The SynchroLock status window and LED indicators show the current state of the SynchroLock
system as described below. Prior to achieving lock,  the four green LED’s give an indication of the completion of various lock stages. For
more information on SynchroLock, refer to the SynchroLock section.

Working: In this state SynchroLock is analyzing the input clock signal and making adjustments to frequency
and phase. This process typically takes two minutes to complete. The four LED’s show progress towards
final lock:  One green LED denotes frequency lock to 3.2 ppm accuracy, two LED’s denote frequency lock to
1.6 ppm accuracy,  three LED’s denote frequency lock to 0.6 ppm and the transition to the phase lock stage,
four LED’s denote the start of the phase lock stage. When phase lock has been achieved, the Yellow
“Working” indicator changes to the green “Locked” indication.

Locked: Indicates the SynchroLock system has achieved final lock to an incoming clock signal. This indicator
will also appear when the Sample Clock Source is set to Internal and the sample clock frequency is a multiple
of 44.1 kHz or 48 kHz

Range: Indicates that the selected external clock source is not within the SynchroLock lock range.

Disabled: Indicates that SynchroLock has been be manually disabled using the SynchroLock control in the
Settings menu: Settings->Advanced->SynchroLock.

System Clock Rates: Displays real-time frequency measurements for each of these clock sources.

L/R Clock: System sample clock.

External: From SYNC IN connector.

Header: From CLOCK IN connector.

LStream: From LStream port on AES Sync connector.

PCI Bus: Computer’s PCI Bus speed.
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Mixer Reference

Window One - Adapter (continued)

Digital Inputs

Digital In
All of the headings except Clock Rate indicate the status of the incoming signal and are not control or measurements functions. They are
merely status indicators showing what is sent by each transmitting device.

Lock
Locked (Green) Shows the digital receiver is locked to a valid AES/EBU source.
Unlocked (Grey) The digital receiver is not locked to a valid AES/EBU source. When the unlocked indicator is shown, all of the fields to
the right will be blank.

Validity
Valid (Green) Indicates Validity of the incoming AES/EBU signal.
Invalid (Red) The transmitting device has marked the data stream as invalid. An example might be a DAT that is hooked up to the AES16,
but is not playing.

Parity
OK (Green)
Error (Red) Indicates a Parity error in the datastream. Most likely a problem with a transmitting device or bad cable.

CS CRC  Channel Status Cyclic Redundant Check
OK (Green)
Error (Red) Indicates an error in the channel status portion of the datastream. This could be corruption in the channel stations portion.
Could also mean that the transmitting device does not indicate a CRC device.

Type
Shows the type of datastream being transmitted by the external device. Typically PCM types are shown with green background and non-
PCM, such as Dolby AC3, have a yellow background. Here is a list of potential types:

PCM PCM16 PCM18 PCM19
PCM20 PCM22 PCM23 PCM24
Non-PCM Dolby AC-3 Pause
MPEG1L1 MPEG1L2 MPEG2 MPEG2AAC
MPEG2L1 MPEG2L2 MPEG2L3 MPEG-4
DTS I DTS II DTS III
ATRAC ATRAC2/3

Emphasis
Off or On indicate if Emphasis bits were turned on by the transmitting device.
50/15us (Green) Curve of preemphasis.
J17 (Green) CCITTJ.17 Emphasis detected.
Unknown (Green) Emphasis is detected, but format cannot be ascertained.
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Rate
Indicates the encoded channel status sample rate being sent by the transmitting device.  Possible values are: 32.0; 44.1; 48.0; 88.2; 96.0;
176.4; 192.0 kHz (all in Green) or Unknown (Red).

Clock Rate
Actual measurement of incoming sample rate.  The Settings Menu offers a “High Resolution Clock Rate” option that provides three decimal
places of accuracy instead of the default one decimal place.

When WideWire (dual-wire) is checked, this Clock Rate should read half of the encoded channel status rate described above.  For example,
when running at 192kHz and WideWire is checked, the Clock Rate should show 96.0 kHz.

Mixer Reference

Window One - Adapter (continued)

Digital Inputs, Digital Outputs

Digital Out

Valid
When checked, the Validity Bit is turned on for this output to indicate valid audio data is being transmitted.

Non-PCM
When checked, the Non-PCM Bit is turned on for this output to indicate that a Non-PCM datastream (such as Dolby AC3 or DTS) is
being transmitted.

Emphasis
When checked, the 50/15us Emphasis flag is turned on for this output.
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Window Two - Record / Play Inputs and Routing

Selecting and monitoring the inputs to be sent to each of the AES16’s Recording and
Playback Busses.

Pop-Up Menu: Gives you a the
choice of all available input options
from which to choose.

Example: AES16 with one
LS-ADAT LStream cards.

Sixteen channels of
LStream Port on internal
header. Maps to 16 input
channels of LS-ADAT or
8 channels of LS-AES.

Record Device Source Selection Button: Controls routing of an input source to a recording device.
Each device can derive its source from any one of the 32 available inputs (16 through I/O Port A and I/O Port
B and 16 through the LStream port).

Peak Meters: Displays the instantaneous level of the audio being sent to the AES16.

Mute: Enables mute function for each associated input.

Dither: Enables dither for each associated input. The Dither type is specified in the Settings menu.

Dropout: Shows the actual number of data dropouts during recording or playback. Drop outs indicate
missed data and cause audio glitches.

}
}Record Device Status

Playback Device Status

Sample Format: Indicates 32, 24, 16, or 8 bit-depth setting. This is set by the audio application for each
record device and is provided for reference purposes only.

For Record 1 to Record 8: Shows Red if active.

For Play 1 to Play 8: Shows Red if active.

Activity Indicators: The device labels reflect the name of the associated wave device. When a device is inactive, its label is blue. When a
device is active (currently being used in an application for play or record) its label is red.

Mixer Reference
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Window Three - Output Section

Provides selection and level control of the Sixteen outputs.

Output Monitor Source Buttons:
Controls routing of record and playback
sources to each of the sixteen output
channels. Each output is derived from
the sum of the four sources associated
with each button. Your options include
any of the Digital inputs, LStream
inputs or Play 1-8, Left or Right
channels from the Record/Play screen.

Routing of Record sources.

Volume Faders: Controls digital attenuation of the audio being
played or monitored. This control acts on the digital signals
before D/A conversion.

With the volume fader at its maximum position, the vertical line
within the fader turns black, no volume calculation is performed
and the audio stream is unaltered. This is the recommended
position for critical recording and mixdown sessions in which
the highest signal quality is required.

Volume control processing is done prior to peak meter readings
causing the peak When the volume fader is not at its maximum or
minimum position, the vertical line within the fader turns red to
indicate that the volume control is active.

Overload Indicator: Provides instantaneous overload
indication of the audio being played or monitored. The overload
indicator remains set until it is cleared by clicking on the control.
Overloads can occur only when more than one source is driving
an output.

Peak Meters: Displays the instantaneous level of the audio
being played or monitored.

Mute: Enables a mute function for each associated output.

Output Dither: Enables the addition of triangular probability density dither for each
associated output. Dither is recommended when more than one source is driving an
output or when the volume fader is not at its maximum.

Mute: Allows any of the four sources to be independently muted.

Mixer Reference
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Mixer Menu
The Mixer Menu at the top left of the screen allows selection of functions that are global to the mixer.

Mixer Reference

Restore Defaults: Restores all user changeable controls to the factory default settings.

Mixer Scene...: Allows saving and restoring of all user changeable controls to scene
memory.  When selected, a screen similar to the example on the left will appear.  By
default, Mixer Scene memory is empty.  Once you have configured the mixer with the
controls set the way you wish to have them, you may save that mixer “Scene” into scene
memory.  At a later time, that scene may be restored to quickly put the mixer back to
your custom setup.  Scene memory is global to all users on a single computer.  Please note
that when the computer is shutdown the current mixer state is saved, and when the
computer is started back up, the mixer state is restored.  This function is independent of
the Mixer Scene memory.

Restore: To restore a scene from scene memory, select the scene name from the scene
memory list then press the Restore button.  The scene will be instantly recalled from
scene memory and all user settable controls will be restored to the state they were at
when that scene was saved.  The Mixer Scene dialog box will be closed automatically after
the scene is restored.

Save: To save a scene into scene memory, type the name of the scene into the edit
window then press the Save button.  The state of all user settable controls will be stored
into scene memory.  Clicking on an existing scene name, then pressing the Save button will
update/overwrite that scene with the current state of the user settable controls.  The
Mixer Scene dialog box will be closed automatically after the scene is saved.

Delete: To delete a previously saved scene from scene memory, select the scene name
from the scene memory list then press the Delete button.  The Mixer Scene dialog box
will remain open to allow further editing/deleting of scenes.

About Lynx Mixer...: Displays information about the Lynx mixer program and drivers.
Mixer/Driver Version: Displays the current driver version and build number.
Build Date:  Displays the date the driver and mixer were released.
Adapter Name:  Displays the name of the Lynx audio adapter installed.  Up to four Lynx

audio adapters may be shown.
Serial Number:  Displays the serial number of the Lynx audio adapter installed.
PCB Revision:  Displays the revision of the printed circuit board.
Firmware ID:  Displays the firmware identification number.
Firmware Revision:  Displays the firmware revision.
Firmware Date:  Displays the date the firmware was released.

Close: Pressing the close button removes the About Lynx Mixer dialog box from the
screen.

Exit: Closes the Lynx Mixer application.
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Settings Menu

The Settings Menu at the top of the screen offers advanced setting and an alternative method of accessing commonly used controls that
appear in the Adapter Window.

Mixer Reference

Always On Top
For the screen position of the AES16 software. When checked, the Adapter,
Record/Play and Outputs screens stay at the top of the screen for easy
reference. Once settings are set and you want to work more with the
recording or DAW software, unclicking this allows these AES screens to
reside in the background, for easier access to other software.

High Resolution Clock Rates
In the default mode (unchecked), the Clock Rate measurement on the
Digital In portion of the Adapter window will show the clock rate to one
decimal point (1/10th of a kHz). When checked, this measurement is shown
to three decimal places (1/1000th of a kHz.)

Level Meter Range
The meters on the Record/Play and Output screens can be set to three
different ranges. 114 dB provides the widest possible range that the AES16
delivers. If more critical monitoring is required within a smaller range, these
meters can be reset to 96dB or 70 dB ranges. This is a universal setting for all
channels, you cannot set more than one range.

Sample Clock Source
This is a redundant control to the Sample Clock Source in the Adapter window (Page 13). The same options are available in a menu-
select format that may be easier or faster to use in some situations, or if the Adapter Window has been closed.

Sample Clock Reference
As with Sample Clock Source above, this menu item is the same as the Sample Clock Reference on the Adapter window and is
included for convenience.

Record Dither Type
Provides selection of the type of dither used on all record channels. The selection may be one of the following:
None - Dither is disabled. Volume processing utilizes rounding prior to truncation.
Triangular - Enables the addition of triangular probability density dither. Triangular is the preferred dither type in most cases.
Shaped Triangular - This type of dither is essentially a high-pass filtered triangular dither that places most of the dither energy at higher

frequencies making it less audible to the human ear.
Rectangular - This type of dither decreases the signal-to-noise ratio by 3 dB (less than triangular), but is less desirable because of its

noise modulation effects.
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Mixer Reference

Settings Menu

Advanced Settings

SynchroLock™
SynchroLock is Lynx Studio Technology’s proprietary jitter attenuation utility for the AES16. When SynchroLock is engaged, after
calculations are completed, a 3000:1 jitter reduction is achieved.

SyncStart™
Enables the SyncStart feature, which provides sample accurate synchronization of multiple record and playback devices. Defaults to On.

MTC Source
MTC Source: Controls the source of MIDI Time Code sent to an application. The signal received from each source is automatically
converted to MTC. The available sources are:
LTC In  - Time code from the LTC IN connector
LS1 ADAT Sync In – Time code from an LS-ADAT connected to LStream Port 1 (on bracket connector)
LS2 ADAT Sync In – Time code from an LS-ADAT connected to LStream Port 2 (on internal header connector)

Mixer Lock
Turns on a locking feature that prevents changes to any of the mixer windows.
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Working with Third Party Applications

Working with Third Party Applications
Compatibility
The drivers included with your AES16 provide compatibility with all standard third party audio editing applications that communicate
with Windows Wave audio, DirectSound and ASIO devices. A list of applications that have been tested for compatibility is
provided on the Lynx web site at http://www.lynxstudio.com/swlist.html.

AES16 Devices
Third party applications communicate with the AES16 through its installed driver. The driver presents the AES16’s audio capabilities
to applications as standard multimedia, DirectSound or ASIO devices.

Most, if not all, third party applications provide device selection in configuration, options, or preference setting windows or
menus.  For two channel or stereo audio applications, a separate selection option is typically provided for the input or recording
device and the output or playback device. Multitrack applications provide multiple input and output device selection menus or
windows. Refer to the documentation included with your application to determine how to select audio devices.

With the AES16 properly installed in your computer, the digital audio devices will be available to applications, and their names will
appear in their device selection menus as follows:

AES16 Record 1 AES16 Play 1
AES16 Record 2 AES16 Play 2
AES16 Record 3 AES16 Play 3
AES16 Record 4 AES16 Play 4
AES16 Record 5 AES16 Play 5
AES16 Record 6 AES16 Play 6
AES16 Record 7 AES16 Play 7
AES16 Record 8 AES16 Play 8

When more than one AES16 is installed in your system, the device names will contain a numeric adapter ID assigned by the
operating system. For example, the analog output device on adapter 2 would be listed as “AES16 2 Record 1”. Refer to the
“Configuring Multiple AES16’s” section for more information regarding this topic.

Controlling Audio Bit Depth
Creating a audio file with a particular bit depth (or resolution) is controlled through an application’s recording settings. These
settings are typically adjusted in an audio device configuration menu or in a recording setup window just prior to recording.
When recording is initiated the AES16 will generate audio samples of the desired resolution.

Bit depth control during playback of an audio file is also an application issue.  When a file is played, the recorded bit depth is read
from the file’s header by the application. The application uses this information to set the resolution of the AES16.

The AES16 supports file types with 8, 16, 24, or 32 bit word widths. Note that 32-bit files contain 24-bit data with zero data in the
least significant bit positions.

The AES16 Mixer application displays the currently selected bit depth for each device just above the device name in the Record
window and the Play window.

Simultaneous Device and Multitrack Operation
The sixteen audio devices of the AES16 operate completely independent in terms of whether they are in recording or playback
modes and their associated audio files. This implies that the devices can operate simultaneously and support the so-called “full-
duplex” mode where, for instance, the AES16 Record 1 device is recording while the AES16 Play 1 device is playing.

Although the devices act independently, when multiple devices are being used to record or play multiple audio files simultaneously,
the AES16 driver has the capability to synchronously start all devices with sample accuracy. This is especially important for
maintaining synchronization during playback of multiple devices and overdubbing.

By using all of the record and play devices, sixteen track recording and playback is possible. Again, control of this multi-channel
operation is simply a matter of device selection in any compatible multitrack audio application.
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Configuring Multiple AES16’s

Configuring Multiple AES16’s
More than one AES16 card can be installed in a computer for additional audio channels. If required, all AES16’s in a computer can
be configured to maintain sample accurate synchronization during digital audio recording and playback.

Cards are synchronized in a master-slave arrangement. One card is selected as the master which provides the word clock source
for the other slave cards in the system. From the master, the word clock signal is daisy-chained from one slave to the next.

Word clock signals can be connected internally using the CBL-ICC Internal Clock Cable, which is available from Lynx. The CLOCK
OUT header of one card is connected to the CLOCK IN header of the next card. A separate cable is required for each slave card in
the system.

Alternatively, the CLOCK connectors on the CBL-AES1604 cables can be connected externally with a standard 75 ohm BNC cable.

Adapter ID’s in a Multiple Card System
When multiple AES16 cards are installed in a computer they are automatically assigned unique adapter ID numbers. These
adapter ID’s provide a means to identify and communicate with each AES16 when using the AES16 Mixer application and to select
audio devices in third party applications.

In the AES16 Mixer, the adapter that a user wishes to control is selected from the “Window” pull-down menu.  In a system with
four AES16’s the adapters will be listed as follows:

AES16 1 Mixer
AES16 2 Mixer
AES16 3 Mixer
AES16 4 Mixer

In each case, the adapter ID is the numeric character just before the word “Mixer” in each selection.

Most third party applications provide a setup or configuration menu for selecting a desired wave audio device for recording and
playback. With multiple AES16’s in a system, each device name will contain the adapter ID.  For example, the first play device on
adapter 2 would be listed as “AES16 2 Play 1”.

Selection of Master and Slave Clocks
In order to select master and slave AES16’s in a system, each adapter ID must be first physically associated with a AES16 installed
in a computer slot.  Windows 2000/XP assigns the adapter IDs from the lowest slot number to the highest slot number.  The
procedure is as follows:

1. Connect at least OUT1 of each AES16 to your external mixing console or other equipment that will provide audio monitoring.
2. Choose an audio application that allows selection of wave audio devices for audio playback.
3. Select “AES16 1 Play 1” as the playback device.
4. Listen to the playback of any wave file and note which AES16 card is generating the audio signal. In this case, the card

generating audio is adapter 1.
5. Repeat steps 3 and 4, for “AES16 2 Play 1”, “AES16 3 Play 1”, and so on until all AES16’s in your system have been identified.

The next step is to choose which AES16 will act as a master.  This choice is based on preference only, but for ease of connection
it makes sense to choose a AES16 that is on one end of the PCI slot array on your motherboard.
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Configuring Multiple AES16’s

Cable Connections

Starting with the master AES16, insert the plug on one end of a Lynx Internal Clock Cable into the CLOCK OUT header, until it
clicks and locks into place. This header is polarized to ensure the correct orientation of the cable plug. Insert the plug on the free
end of the cable into the CLOCK IN header, on the nearest slave AES16.  Connect each slave in a similar manner.  Refer to the figure
below:

Alternatively, if clock connections are made externally using the CLOCK connectors on the CBL-AES1604 cables, use BNC cables
to make connections between cards in the same sequence as described above.

Mixer Settings

With the clock connections in place, the sample clock settings of each AES16 must be adjusted using the AES16 Mixer.

For the master AES16:
1. Select the master AES16 Adapter page from the Window pull-down menu.
2. Select a desired Sample Clock Source.
3. Select a desired Sample Clock Reference.

For each slave AES16:
1. Select the slave AES16 Adapter page from the Window pull-down menu.
2. Set the Sample Clock Source to Header if internal clock connections are used or External if external clock connections are

used.
3. Set the Sample Clock Reference to Word.

I/O PORT A

I/O PORT B

LSTREAM

AES16 Master

Internal Clock Cable

I/O PORT A

I/O PORT B

LSTREAM

AES16 Slave 1

AES16

I/O PORT A

I/O PORT B

LSTREAM

AES16 Slave 2
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Support

We are devoted to making your experience with AES16 trouble-free and productive.
If you have questions or comments regarding the operation of your AES16 please  check the “Troubleshooting” section of this
manual and the FAQ and Troubleshooting topics on the Support section of the Lynx web site at:

http://www.lynxstudio.com/support.html

If you are unable to find information about your problem please send us a support request by filling out the form at:

http://www.lynxstudio.com/supportrequest.html

In your email message include the following information:
• The serial number of your AES16.
• Which operating system you are using.
• The type of computer you are using.
• The name of the application you are using.
• A detailed description of the problem including any error messages you received.

We will provide a response in a timely manner.

Telephone support is available by calling (949) 515-8265 from 9AM to 5PM Pacific Time, Monday through Friday, excluding
Holidays.  Please be sure to have the above information available before calling.
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Appendix
Specifications

AES16 Standard model without cables. Refer to the optional cables listed below.

AES16-XLR Includes two six-foot D-sub to XLR cables sets.

AES16-SRC Includes XLR cable sets and eight channels of onboard sample rate conversion.

MODELS

 DIGITAL I/O
Number/Type Eight stereo inputs and eight stereo outputs

24-bit AES/EBU format, transformer coupled
Channels 16 in/out in single-wire mode

8 in/out in dual-wire mode
Sample Rates All standard rates and variable rates up to 192 kHz in both single-wire and dual-wire modes
Sample Rate Eight channels available with support for conversion ratios up to 8:1

Conversion Dynamic range: 142 dB
Multiple-input SRC phase matching
Available on AES16-SRC model only

 ARCHITECTURE
Core FPGA-based core contains custom PCI interface, data routing and formatting, device control, digital mixing,

clock routing and control, and DMA engine.
256 Kbytes of on-board RAM for data buffering
Support for field upgrades of firmware.

Audio Devices Card is visible to host applications as eight record devices and eight play devices. Each device has two
channels and can be used independently for multi-client functionality.

 CLOCKING
Sources Digital inputs 1 - 4, external word clock (with XLR cables only) on BNC, internal word clock on header, on-

board low-jitter crystal oscillator
SynchroLock™ Multi-stage, VCXO-based clock generation system with high jitter attenuation. Wide mode tracks off-

frequency clocks, narrow mode generates ultra-low jitter output for standard frequencies.

 ON-BOARD DIGITAL MIXER
Type Hardware-based, low latency

Routing Ability to route any input to any or multiple outputs
Mixing Up to four input or playback signals mixed to any output, 40-bit precision
Status Peak levels to -114 dB on all inputs and outputs

 LSTREAM™ EXPANSION PORT
Compatibility Supports Lynx LStream expansion cards including the LS-ADAT 16-Channel ADAT I/O card

Type High-speed serial, up to 16 channels @ 24-bits on 14-pin internal connector

CONNECTIONS
I/O Ports Two bracket-mounted 26-pin high-density female D-sub connectors

Can be configured to support eight channel or four channel AES connections
External Clock 75-ohm BNC word clock input and output provided on XLR cable set
Internal Clock Two 75-ohm board mounted 2-pin headers for word clock input and output

 SOFTWARE
Windows Drivers For Windows 2000 / XP platforms: MME, ASIO 2.0, WDM, DirectSound, Direct Kernel Streaming and GSIF

Macintosh Drivers ASIO for OS9; CoreAudio for OSX
M ixer Application Multi-window GUI provides complete control of digital mixer and all hardware settings
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 GENERAL
PCI Bus Version 2.2 compliant

Data Transfers Up to 132 Mbytes/sec using custom 16-channel zero-wait state, scatter-gather DMA engine Bus mastering
supported

Size 5.0" H X 7.4" W X 0.75" D (standard half-size PCI card)

 CABLES
Included with CBL-AES1604 (qty. 2): 26-pin high-density male D-sub to four female XLR’s (AES inputs), four male XLR’s

AES16-XLR & (AES outputs), and two female BNC’s (word clock I/O)
AES16-SRC only Six-foot, 110-ohm shielded twisted pair cable

Optional cables for CBL-AES1603: 26-pin high-density male D-sub to 25-pin male D-sub. Supports either 8 channels of input or
AES16 Standard output. Compatible with Apogee AD16 and DA16 Twelve-foot, 110-ohm shielded twisted pair cabling

Model CBL-AES1605: 26-pin high-density male D-sub to 25-pin male D-sub. Supports 4 channels of input and
output. Compatible with devices with standard Yamaha digital I/O pinout from Yamaha, Apogee, Mackie, and
others. Twelve- foot, 110-ohm shielded twisted pair cabling

Other cables will be offered for connection to equipment from Tascam, Sony and digidesign. For a complete up-to-date list of all
products supported, please go to http://www.lynxstudio.com.
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Instructions to the User

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation.  If this equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

•  Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

•  Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-
approved equipment or unshielded cables is likely to result in interference to radio and TV reception.  The user is cautioned that
changes and modifications made to the equipment without the approval of manufacturer could void the user’s authority to
operate this equipment.

Appendix
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License Agreement
This legal document is an agreement between you and Lynx Studio Technology, Inc.  By opening the sealed board package, or written materials, you are agreeing to
become bound by the terms of the agreement, which includes this License and Limited Warranty (collectively the “Agreement”).  This Agreement constitutes the
complete agreement between you and Lynx Studio Technology, Inc.  If you do no agree to the terms of the Agreement, DO NOT OPEN the anti-static bag containing
the AES16 board.  Promptly return the unopened package and all other items using the original packaging to the location of purchase.

Limited Warranty
Lynx Studio Technology, Inc. (“Lynx”) warrants this product to be free of defects in material and workmanship for a period of one year from the date of original
retail purchase.  This warranty is enforceable only by the original retail purchaser.  To be protected by this warranty, the purchaser must complete and return the
enclosed warranty card within 14 days of purchase.
During the warranty period Lynx shall, at its sole and absolute option, either repair or replace free of charge any product that proves to be defective on inspection
by Lynx or its authorized service representative.  In all cases disputes concerning this warranty shall be resolved as prescribed by law.
To obtain warranty service, the purchaser must first call or write Lynx at the address and telephone number printed below to obtain a Return Authorization Number
and instructions concerning where to return the unit for service.  All inquiries must be accompanied by a description of the problem.  All authorized returns must be
sent to Lynx or an authorized Lynx repair facility postage prepaid insured and properly packaged.  Proof of purchase must be presented in the form of a bill of sale,
canceled check or some other positive proof that the product is within the warranty period.  Lynx reserves the right to update any unit returned for repair.  Lynx
reserves the right to change or improve design of the product at any time without prior notice.
This warranty does not cover claims for damage due to abuse, neglect, alteration or attempted repair by unauthorized personnel, and is limited to failures arising
during normal use that are due to defects in material or workmanship in the product.
ANY IMPLIED WARRANTIES, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
LIMITED IN DURATION TO THE LENGTH OF THIS LIMITED WARRANTY.  Some states do not allow limitations on how long an implied warranty lasts, so
the above limitation may not apply to you.
IN NO EVENT WILL LYNX BE LIABLE FOR INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES RESULTING FROM THE BREACH OF ANY
EXPRESS OR IMPLIED WARRANTY, INCLUDING, AMONG OTHER THINGS, DAMAGE TO PROPERTY, DAMAGE BASED ON INCONVENIENCE OR ON
LOSS OF USE OF THE PRODUCT, AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURY.  Some states do not allow the
exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.
This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.
This warranty only applies to products sold in the United States of America or Canada.  The terms of this warranty and any obligations of Lynx under this warranty
shall apply only within the country of sale.  Without limiting the foregoing, repairs under this warranty shall be made only by a duly authorized Lynx service
representative in the country of sale.  For warranty information in all other countries please refer to your local distributor.

Your warranty will be in effect and you will receive warranty information ONLY IF YOU REGISTER YOUR
AES16 as described in the “Warranty Registration” section.

Lynx Studio Technology, AES16 and the AES16 Logo are trademarks of Lynx Studio Technology, Inc.  All other product or company names are
the trademarks or registered trademarks of their respective owners.
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